
NutriSoft  Weight  Perfect

for Windows version 2.0

USER'S GUIDE

"Excess weight or overweight occurs when too few calories are expended and too many
consumed for individual metabolic requirements. The extraordinarily high prevalence of obesity in

the United Stated--one-fourth of American adults are overweight and nearly one-tenth are
severely overweight--coupled with its role as a risk factor for diabetes, hypertension, coronary

artery disease and stroke, gallbladder disease, and some types of cancer, suggests that a
reduction in the average weight of the general population would improve the Nation's health.

Americans, in general, would benefit from a lifestyle that includes more physical activity and a
diet containing fewer calories."   U.S. Surgeon General

NutriSoft Weight Perfect is a Microsoft Windows program that allows you to monitor your diet and 
establish a plan to lose (or gain) weight.

The program calculates the amount of fat, carbohydrate, protein, and calories in your food 
consumption using a standard database of common foods or your own data. It analyzes the 
caloric contribution from fat, protein and carbohydrate from the food you eat and helps you obtain 
a more healthful diet.

It also provides utilities to calculate your ideal weight, body mass index, suggested daily caloric 
and maximum fat intake.

You can save the daily plan for later retrieval and print out reports of the program's nutritional 
analyses.

Flexible and powerful, this well-designed program is indispensable to anyone who wants to 
achieve a more desirable weight. 

Some of the more important enhancements in version 2.0 include:
- convenient food search capability
- user's food database support
- printer font selection
- graphic analysis of nutrients.

Commands
File menu
View menu
Tools menu
Options menu
Window menu
Help menu



1. File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Setup Selects a printer and printer connection.
Exit Exits NutriSoft Weight Perfect.

a. New command (File menu)

Use this command to create a new document in NutriSoft Weight Perfect.
You can open an existing document with the Open command.

Shortcuts
Keys: CTRL+N

b. Open command (File menu)

Use this command to open an existing document in a new window.  You can open multiple 
documents at once.  Use the Window menu to switch among the multiple open documents.  See 
Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts
Keys: CTRL+O

c. File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.  This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open.

Drives
Select the drive in which NutriSoft Weight Perfect stores the file that you want to open. 

Directories
Select the directory in which NutriSoft Weight Perfect stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

d. Close command (File menu)

Use this command to close all windows containing the active document.  NutriSoft Weight Perfect
suggests that you save changes to your document before you close it.  If you close a document 
without saving, you lose all changes made since the last time you saved it.  Before closing an 
untitled document, NutriSoft Weight Perfect displays the Save As dialog box and suggests that 



you name and save the document.

e. Save command (File menu)

Use this command to save the active document to its current name and directory.  When you 
save a document for the first time, NutriSoft Weight Perfect displays the Save As dialog box so 
you can name your document.  If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts
Keys: CTRL+S

f. Save As command (File menu)

Use this command to save and name the active document.  NutriSoft Weight Perfect displays the 
Save As dialog box so you can name your document.  

Important:
You should save all your files in the directory where you install NutriSoft Weight Perfect. The 
Weigh Control planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.

g. File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.  A filename can contain up to 
eight characters and an extension of up to three characters.  NutriSoft Weight Perfect adds 
the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

h. 1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.  Choose the number that corresponds with the document you want to 
open.

i. Exit command (File menu)

Use this command to end your NutriSoft Weight Perfect session.  You can also use the Close 
command on the application Control menu.  NutriSoft Weight Perfect prompts you to save 
documents with unsaved changes.



2. View menu commands

The View menu offers the following commands:

Caloric Analysis
Shows graphic analysis of percentage of calories from protein, carbohydrate and fat.

Nutrient Analysis
Shows graphic analysis of the individual nutrient contents from your daily food consumption.

Toolbar
Shows or hides the toolbar.

Status Bar
Shows or hides the status bar.

a. Caloric Analysis (View menu)

Do you need a more healthful diet? This menu item displays a graph showing the number of 
calories in your diet that comes from protein, carbohydrate or fat.

b. Nutrient Analysis (View menu)

Are you eating too much at dinner and not enough at breakfast? Check out the relative nutrient 
intakes of all your daily meals.

c. Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in NutriSoft Weight Perfect, such as File Open.  A check mark appears next 
to the menu item when the Toolbar is displayed.

Context Help command 

Use the Context Help command to obtain help on some portion of NutriSoft Weight Perfect.  
When you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.  Then click somewhere in the NutriSoft Weight Perfect window, such as 
another Toolbar button.  The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1

d. Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed 
by the selected menu item or depressed toolbar button, and keyboard latch state. A check mark 
appears next to the menu item when the Status Bar is displayed.



3. Tools menu commands

The Tools menu offers the following commands:

Weight Control Plan
Use this dialog box to set short and long-term plan for weight control.

Body Mass Index
Calculate your Body Mass Index (BMI) to determine if you have desirable weight or are 
overweight or obese.

Desirable Weight
Determine your ideal weight based on your sex, height and body frame.

Caloric Need
Find out your daily caloric need.

a. Weight Control Plan (Tools menu)

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for any 
number of days. Find out how much weight you will gain or lose in a week, a month or a year; and
whether you are consuming too much fat in your plan.

b. Body Mass Index (Tools menu)

Are you thin, or are you overweight? This dialog box uses the Body Mass Index (BMI) calculated 
from your height and weight to chart your precise standing. Compare your BMI with that of an 
average person, or an obese individual. 

c. Caloric Need (Tools menu)

Find out how many calories you need a day based on your age, desirable weight and activity 
level. The dialog box also shows the maximum recommended fat consumption in your diet.

d. Desirable Weight (Tools menu)

This menu item displays a dialog box which allows you to determine your ideal weight based on 
your sex, height and body frame.



4. Options menu commands

The Options menu offers the following commands:

Search Mode
Allow you to search for any specific food from the standard and personal food databases.

Food Groups Mode
Display food items according to food groups.

Personal Food Database
Display food items from your personal food database.

Choose Printer Font
Select your favorite printer font for your nutritional and weight planning report.

Set Fat Warning Level
Set threshold beyond which you are alerted when a food item has more than certain percentage 
of calories from fat.

a. Search mode

This is one of the most convenient features of NutriSoft Weight Perfect. It allows you to find any 
particular food items from the standard and user databases without your having to browse 
through different categories of food groups.

When this mode is selected, an edit control is displayed in place of the Food Group combo box. 
You type in the name of the food item you want to find, for example "apple", then click on the 
Search push button (or type Alt-S). The list box will be filled with all food items containing "apple". 
You don't need to type in a complete word: "app" will suffice. On the other hand, when there are 
too many matching food items, you might want to restrict the match by specifying longer name 
such as "apple juice". The search is not case sensitive: you can use lower or upper case letters 
and this won't affect the result.

The program will look for matching entries not only in the standard food database that comes with
your software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other mode.

In the registered version of the software, there is no restriction on the size of the user database 
on which the search will be performed. However, memory limitation of your system might prevent 
the display of all matched entries in the list box. In this case, a message box will appear to alert 
you of this situation.

In the shareware version, search will be performed on the abbreviated standard database and on 
the first 10 records of the user database.

b. Food Groups Mode

In this mode, the default mode, you will see a pull down list box that contains approximately 30 
food groups such as "Beverages", "Oils", "Beef", etc. By selecting any of these food groups, the 
food items belong to the group will be displayed in the list box immediately below. This mode is 
useful when you want to browse through the standard database, or when you want to do your 
menu planning which requires selection of foods from different food groups.



c. Personal Food Database

Naturally, not all foods in your diet are listed in the standard database. What do you do when 
you've just eaten a serving of Haagen-Dazs ice cream? Or want to include a favorite TV dinner in 
your weekly plan? Most of these items do have nutritional information on their packaging. 
NutriSoft Weight Perfect can access and use their nutritional information once you've entered the 
data into your personal food database.

Choosing Personal Food Database from the Options menu will display all food items from your  
database in the list box. This mode is convenient when your diet consists mainly of special food 
items or when you just want to browse the contents of your data.

The capability to process user's food data is one of the important enhancements in this version of 
NutriSoft Weight Perfect. The user food database is a file named 'userfood.txt'. The file can be 
edited using any plain text editor such as the Windows's notepad program. You can also use a 
database program such as Access, FoxPro, or Paradox, etc. or any spreadsheet program such 
as Excel or Lotus 1-2-3 to create this database and export/save the database to/in the plain text 
format. 

The format of each record (entry, line) in this database is:
- food name in double quotes ( e.g., "Quarter Pounder with Cheese" )
- weight of food in grams (e.g., 250 )
- calories from food in Kcalories (e.g., 300 )
- protein from food in grams (e.g., 30)
- carbohydrate from food in grams (e.g., 150)
- fat from food in grams (e.g., 50)

Each food item must be stored on a single line and each nutrient information is separated from 
one another by a comma so the above food item is recorded as:
"Quarter Pounder with Cheese", 250, 300, 30, 150, 50
Space(s) before or after the commas is optional.
Please print out the file 'userfood.txt' for sample entries.

d. Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight Planning 
Report.

e. Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want to be 
alerted. For example, if you want to identify foods that has more than 50% of their calories 
derived from fat, you should set this value through the Set Fat Warning Level dialog box. From 
then on, each time a food item is consumed, a green or red symbol will be displayed to indicate 
whether its fat content is below or above the limit you set. When you print out your nutritional 
report, each food item exceeding this limit is also flagged with an asterisk before its name.



5. Windows and dialog boxes

a. Modifying the Daily Food Consumption

To modify a daily food consumption document, you first select a meal you want to record the data 
for. There are 6 meals in a day: Breakfast, Morning Snack, Lunch, Afternoon Snack, Dinner and 
Evening Snack. Select one from the left pull-down list box. 

Then you select a food group from the right hand side pull-down list box. (There are 
approximately 30 food groups.)

[Alternatively, instead of the Food Group mode, you can specify the Search mode from the 
Options menu. Or you can use your own food database.]

Select a food item in the right list box, click on the 'I Eat' button. This item will be recorded in the 
meal you selected.
If necessary, you can adjust the number of servings for this food item by typing the desired 
amount in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been 
typed in, click on 'Amt. OK' to confirm and record this value.

If a food item is not what you intended to add to a meal, you can highlight it and then click on the 
'Delete' button to remove it from your meal.

Repeat the food selection process for each meal, omitting the meals where you don't eat any 
food.

When you are done, you can save the day food consumption data for later review or for use in 
your weight control planning.

b. Weight Control Plan

"To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both."
U.S. Surgeon General

It's hard to achieve your weight goal without planning. This utility allows you to establish a plan 
and estimate precisely how much weight you will gain or lose when you follow this plan. 

Weight Perfect plan is truly flexible: you can set a food plan to be repeat every week, every 3 
days or every 10. 

Once an entry is added into your plan, you can double-click on its name in the plan (left) list box 
to review its nutritional content.

After setting up your plan, print out a report to keep track of your food intake and to motivate 
yourself to achieve your goal.

Important: Extremely low-calorie diets, 300 - 400 kcal per day, are not recommended. Dietary 
deficiencies are less likely to occur with diets higher in calories (range of 800 kcal or above). This 
is where NutriSoft Weight Perfect can help you identify and avoid risky diets.

c. Desirable Weight

This dialog box calculates the desirable weight based on your height, sex and frame. The 
desirable weight is that associated with lowest mortality.



Use the spin controls to specify your height (without shoes) and frame. Specify your sex by 
selecting the appropriate radio button.

If you close the dialog box by clicking the OK button, the information will be saved and 
redisplayed next time you invoke the dialog box. Use the Esc key to close the dialog box without 
saving.

d. Body Mass Index

This dialog box calculates your Body Mass Index (BMI) which is used to determine if you have 
desirable weight, are overweight or obese.

You are overweight if your weight is at the 85th percentile or more of the distribution of BMI and 
you are obese when your BMI exceeds the 95th percentile of the distribution.

For men, you are overweight when your BMI is 27.2 or higher and obese when it exceeds 31.8.
For women, the corresponding BMI values are 26.9 and 31.4.

Specify your weight and height using the spin buttons. Select your sex via the radio buttons. Your 
BMI is calculated interactively.

The bar chart depicts the BMI values of an average person of your sex, an overweight person, an
obese person in this order. The last bar is your BMI value for comparison.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu
or hit Esc. If you click OK, the currently specified height, weight and sex will be retained for next 
time you invoke the dialog box.

e. Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or
carbohydrate, the general public would benefit from reduced fat intake." 

U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when NutriSoft Weight Perfect 
should warn you when a food item exceeds the limit. A green or red symbol is displayed 
appropriately. When you print out your nutritional analysis of your diet, each fatty food will also be 
marked with an asterisk for easy recognition.

f. Caloric Need

This dialog box calculates your daily caloric need and suggested total fat intake according to your
age, ideal weight and activity level.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges from 
1 (sedentary) to 10 (strenuous).

Suggested total fat intake is based on the American Heart Association's recommendation that no 
more than 30% of your calories come from fat.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu
or hit Esc. If you click OK, the current information is saved for next time you invoke the dialog 



box.

g. Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat? This 
graph displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combo box and the graph shows the percentage of protein that comes 
from breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in counter 
clockwise order. 

The analyses are provided for weight, calories, protein, carbohydrate and fat.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu
or hit Esc. If you click OK, the currently selected nutrient will also be initially selected next time 
you invoke the dialog box.

h. Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the current 
day or for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food 
consumption. The right graph shows the day's caloric intake and a pie chart depicting the 
percentages of calories from protein, carbohydrate and fat in counter clockwise order. Each 
nutrient is color coded for easy identification.

You should pay particular attention to the percentage of calories from fat. The American Heart 
Association recommends that your total fat intake be no more than 30 percent of your total 
calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.

i. Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



6. About NutriSoft

NutriSoft was established by a group of Stanford University researchers to provide consumers
with quality software to help them achieve better health. Your suggestions and comments on our
products are much appreciated. Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309
America Online:NutriSoft
Internet: NutriSoft@aol.com

We welcome inquiry from authors, institutions, and publishers who would like to license our 
software to use with their own nutritional data.

List of software products released by NutriSoft as of September, 1993:

Fat and Cholesterol Counter for Windows, v. 1.1 ( $19 )
This program is a perfect companion to American Heart Association's Fat and Cholesterol
Counter, a guide for everyone who wants a more healthful diet.

Control Diabetes for Windows, v. 1.2 ( $29 )
Essential tool for accurate monitoring of diabetic diet.

NutriSoft Weight Perfect for Windows, v. 2.0 ( $35 )
Indispensable to anyone who wants to achieve a more desirable weight.



REGISTRATION FORM

Name:

Address:

City:

State: Zip:

Please indicate which software product(s):

1. Fat and Cholesterol Counter for Windows, v. 1.1 ( $19 )

2. Control Diabetes for Windows, v. 1.2 ( $29 )

3. NutriSoft Weight Perfect for Windows, v. 2.0 ( $35 )

Disk size: 3.5" 5.25"

Foreign order: please remit in US currency and add $1 for airmail postage.

Please send check or money order to:

NutriSoft
P. O. Box 8226

Stanford, CA 94309


